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Preface

The intended audience, document organization, and conventions used herein are
described. Related documentation is identified, as are instructions for accessing other
electronic product documentation.

Audience

This document is intended for technical users who have a basic level of understanding,
familiarity and experience with network test and measurement equipment.

Conventions

The following conventions are used in this document.

Convention Description

Indicates a command or a feature is not available in the
current release.

Courier Font lllustrates an example command or a concept.
Light Blue Font A clickable hyperlink to a referenced source.
Normal Bold Font A concept or idea important enough that the reader’s

attention is being explicitly focused.

Red Font Additional information on the topic.

C@ Note: This symbol means take note. Notes contain helpful suggestions or references for
additional information and material.

Caution: This symbol means be careful. In this situation, you might do something that
could result in equipment damage or loss of data.

Obtaining Latest Documentation and Software

Please visit the thinkRF website at https://thinkrf.com/documentation/ to obtain the latest
product documentation. Software and firmware releases are also available on the
thinkRF website at https://support.thinkrf.com/support/solutions.

Document Feedback

Please send any comments regarding thinkRF documentation to support@thinkrf.com.
We appreciate your feedback.

Spectraware - Spectrum Viewer User Guide v1.2.0
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Obtaining Technical Assistance

For all customers who hold a valid end-user license, thinkRF provides technical
assistance 9 AM to 5 PM Eastern Time, Monday to Friday. Contact us at
https://support.thinkrf.com/ or by calling +1.613.369.5104.

Before contacting support, please have the following information available:

e thinkRF product's model, serial number (S/N), version (located on the
identification label on the product's underside), and firmware version. Or see
“Device Info” in the Menu Bar section.

e The Spectraware version’s information from the Spectraware’s About page.

e The operating system and version you are using.

e |f the web version is being used instead of the standalone version, provide the
browser and its version.


https://support.thinkrf.com/

‘ Spectraware Overview

The Spectraware (hereafter referred to as Spectraware) is a modern, web-based
spectrum analysis application designed to interface with a range of thinkRF products,
including:

o Real-Time Spectrum Analyzers (RTSAs), such as the current R55x0, R57x0
and R6000 series,

e Spectrum eXperience Management (SXM) products and solutions, which
incorporate RTSA products in their hardware components, and

e as well as future devices.

Designed for usability and performance, Spectraware offers both standard and advanced
spectrum analysis capabilities. Key features include precise frequency and bandwidth
controls, power measurements, flexible windowing options, and robust support for
multiple marker configurations and trace configurations. The application also offers
multiple plot types as well as recording and playback for post-analysis.

thinkRF RTSA devices are high-performance, software-defined RF receivers, digitizers,
and analyzers. Leveraging patent-pending receiver technology, RTSAs deliver industry-
leading sensitivity, tuning range, instantaneous bandwidth (IBW), and scan rates. The
hybrid RF front-end (RFE) architecture integrates super-heterodyne, direct-conversion,
and/or direct digitization techniques, using wideband ADCs to enable both streaming and
sweeping modes for real-time signal capture.

As the software companion to thinkRF hardware, Spectraware serves as a user interface
window for visualizing and analyzing RF signals such as 4G LTE, 5G NR, Wi-Fi, and
other wireless technologies. Communication with RTSA devices is handled through
thinkRF’s proprietary API, libtrf, while with SXM solutions communicate via the SXM API
and associated cloud services.

This document serves as the User Guide for the Spectrum Viewer and Demodulation
features of the Spectraware application.

Supported thinkRF Products

Spectraware currently supports the following thinkRF RTSA products:

e R55x0-408/418/427
e R57x0-408/418/427
e R6000-408 Ethernet connection

And SXM products

e SXM v2.1 with direct or local network internet connection

User Interface

Spectraware is a modern, web-based Graphical User Interface (GUI) application that
significantly enhances the user experience and feature set compared to the earlier
thinkRF S240 software series. While introducing substantial improvements and new
features, Spectraware retains a familiar set of controls to ease the transition for existing
users. As with the S240, it emphasizes intuitive Center, Span, Start, and Stop
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frequency settings, focusing on user-centric interaction rather than the underlying RTSA
technology and modes.

The application currently includes two primary features — Spectrum Viewer and
Demodulation.

e The Spectrum Viewer module allows users to control key parameters such as
Frequency, Amplitude, and Bandwidth, and provides access to additional
visualizations like Spectrogram, Persistence, and Time-Domain 1/Q plots. It
includes various measurement tools and supports recording and playback of
signal data in both the frequency and time domains.

e The Demodulation module enables demodulation of AM and FM signals (see
Demodulating Data for further details). It includes plotting options and the ability
to play back audio derived from demodulated signals.

When the Spectraware application is launched, the Spectrum Viewer tab is selected by
default.

This section provides an overview of the user interface (Ul) layout and the placement of
its components, as illustrated in Figure 1.

Figure 1: The Spectraware Ul layout and the placement of its components

Plots and Top Panel

The application is centered around its main Plots display area. The Spectral Plot (as
illustrated in Figure 1, for example) shows the processed power spectrum of the captured
signal as a function of frequency, in either real-time or playback mode. When available for
a Spectral plot and enabled from the top panel, the Zoom Control offers a convenient



way to navigate and explore the spectrum while the spectrum is zoomed in, allowing
users to easily glide across the current frequency span.

Key parameters—Center, Span, Start and Stop frequencies, Resolution Bandwidth
(RBW), Refresh Time, Sweep Time, and Sweep Speed—are displayed directly below
the plot for easy reference.

The top panel above the plot area contains context-specific information and control
buttons related to the plot(s). For instance, the Spectral Plot’s top panel includes trace
and marker details (when applicable), along with cursor control buttons. In the
Persistence Plot, users can adjust the persistence Decay Time using a dropdown menu.
Hovering over any icon provides a tooltip with a brief description of its function.

For the Spectrum Viewer, additional panels such as Persistence, Spectrogram, Time-
Domain Plots, and the Marker Table can be enabled and will appear below the Spectral
Plot. These panels can be vertically resized by dragging the horizontal divider between
them, allowing users to customize the layout and optimize the interface to suit individual
needs and preferences.

At the bottom of the Spectrum Viewer’s plot area, the Span Control bar, which can be
enabled from the Frequency settings panel on the left, offers a fast and convenient way
to adjust the frequency range, serving as an alternative to using the controls in the
Frequency settings panel.

Plot Zooming

Every plot, except the spectrogram, can be zoomed in and out by scrolling the mouse-
wheel on the point of interest. Users can also do Rubber-band zoom by dragging an
area to zoom in on the selected plot section (see Figure 2).

The zooming can be reset by double-clicking the plot area or clicking on the Reset Zoom

icon ﬂ on the top-right of the plot which will be shown when hover over the plot.

Note: When using this zoom feature and the vertical or horizontal cursors happen to be
outside the zoomed range, they won't be repositioned automatically to the zoomed in
area in order to preserve their original positions.

To bring them to the zoomed area, enter the desired value to the cursor input field. Note
that toggle the cursor button off and on will, by default, place the vertical cursor to the
Center frequency or the horizontal cursor to -100 dBm.




-30.00

-40.00

-50.00

-60.00

-70.00

-100.00

-110.00

-120.00

-130.00

“'l\\ |'.‘

|
) 1 ‘

M“UIJ | Hl.ﬂh"hw i('..' i Wi
Uil ‘ \M IW H\ H\'\ _HHH | Hh.i.m

85000000 '90.000000 95000000 100.000000 105.000000 110.000000 115.000000
Frequency (MHz)

Figure 2: Draw a box on a plot area to zoom

Some plots, such as the Spectral plot, provides a convenient Zoom Control bar that can
be used in conjunction with the direct zoom on the plot.

Cursor Buttons of a Plot

Above the Spectral and Spectrogram plots, there are cursors and crosshair buttons in the
top left section. These tools are typically used for more precise analysis and
measurements within spectral and spectrogram displays.

Button Function

H1, H2 Add a horizontal cursor to the plot.
Atext input will be shown beside the button to allow user viewing or
— editing (when available) the cursor position when the button status is
ON. When both H1 and H2 cursors are added, the delta value between
two horizontal cursors will be displayed beside the cursor buttons. See
Adding Cursors and The Crosshair section for more information.

V1, V2 Add a vertical cursor to the plot.
@ E A text input will be shown beside the button to allow user viewing or
editing (when available) the cursor position when the button status is

ON. When both V1 and V2 cursors are added, the delta value between
two vertical cursors will be displayed beside the cursor buttons. See
Adding Cursors and The Crosshair section for more information.

Crosshair Add a crosshair to the plot.
|;| See Adding Cursors and The Crosshair section for more information.

Configuration Panels

The Plot section is surrounded by various configuration panels and control buttons,
organized as follows:

o Left-side configuration panels contain frequently used settings that directly
affect the RTSA, such as Amplitude, Frequency, and/or Bandwidth. More details
on these settings can be found in the relevant sections of this document. These
panels can be expanded or collapsed by clicking their titles or the arrow icons
beside them. All left-side configuration panels can be expanded simultaneously.



e The top-right control button panel contains ‘run control’ buttons used for
changing capture modes and resetting the application. See Run Control Buttons
section for more information.

¢ Right-side configuration panels contain settings that influence plot behavior,
signal display, and recording/playback functions. Like the left-side panels, they
can be expanded or collapsed via their titles or arrows. However, only one right-
side panel can be expanded at a time.

By default, all configuration panels and control buttons are visible. The left and right

JLu 7
panels can be shown or hidden using the Show or Hide Settings Panel button
as described in the Layout Buttons section. The availability and content of these panels
vary depending on the active Spectraware feature module, as detailed throughout this
document.

Run Control Buttons

The following table summarizes the run control buttons for the plotting in the top right
panel with a brief description of their function.

Button Function
n Pause Capture Pauses the Continuous Capture and displays the last
frame that was captured. Only available when continuous

capture is playing.

Continuous Capture Start the continuous capture and display of signals. Only
available from a paused capture.

Single Capture / Performs a single capture (or next capture in playback) and
Next Capture display of signals. Only available from a paused capture.
I d Preset Restores the application to its start-up state. See Restoring
Spectrum Viewer Defaults section for more information.

Layout Buttons

The layout buttons on the top right of the screen allow user to take a screenshot or
show/hide the configuration panels.

Button Function
m Take Screenshot Captures the current Spectraware’s user interface view.
See Capturing a Screenshot section for more information.

Show/Hide Config Panels Shows or hides all the left and right configuration panels.

JL [
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Menu Bar

File ~ Device - Settings - Help -~

The Menu Bar, which can be found on the top left of the screen, offers a tidy location for
additional controls for the RTSA device or the application itself.



Menu Options

Function

File Load Settings

Load a previously saved configuration file, as explained in
Loading Configuration Settings.

Save Settings

Save the current Spectraware settings into a file, as
explained in Saving Configuration Settings.

Device Disconnect
Device

Disconnect the currently connected device and open the
Connect Device dialog.

Device Info

Display the IP, network MTU, model, serial number,
product version, and firmware version of the currently
connected device.

Device Location

Display the geolocation tracking data of the currently
connected device only if that device has the GNSS
module.

Settings DC Offset

Turn on/off the DC Offset Correction setting, which is on by

Correction default.
Spectral Turn on/off the Spectral Flattening setting, which is on by
Flattening default.

Themes - Dark
(Default)

Change the user interface to dark color theme (as shown in
Figure 22).

Themes - Light

Change the user interface to light color theme (as shown in
Figure 23).

Help User Guide Opens the Spectraware User Guide documentation (this
document).
About Opens a dialog that contains application information
Spectraware including version number, support contact and copyright

notice.

Feature Navigation Headings

The Feature Navigation Headings under the Menu Bar are tabs for different Spectraware
product features such as Spectrum Viewer, Demodulation, and

. Currently, we only support Spectrum Viewer and Demodulation. Other features
are planned additions to the Spectraware and currently, thus, disabled.



Getting Started

System Requirements

Before installing Spectraware, ensure that your PC meets the following minimum system
requirements:

e Operating System:
o 64-bit
o Windows 10, 11
o Debian based distributions (Debian, Ubuntu, Mint, Kali, etc.)
¢ RAM: 4 gigabytes (GB). Recommendation: 8 to 16 GB improves performance.
e VRAM/GPU: minimally 256MB. Preferred 1GB or more.
e Hard Disk: Minimally 1 GB available. Recommend: SSD drive improves the
record and playback performance.

%l\ Issue Note: The plots in Spectraware are implemented with WebGL. Computers with
Intel HD 620/630 hardware have some known issues with WebGL, which might cause
the GUI to hang while the application is running. Please update the Intel HD to the latest
driver license.

Installing Spectraware Software

The section will go over acquiring the Spectraware installer, installing, and running the
software on your computer.

The latest Spectraware could be downloaded from the “Spectraware” section of
https://support.thinkrf.com/support/solutions or via thinkRF’s customer support team.

The software comes in two versions:

¢ Standalone version — Provided to RTSA users (with valid device licenses) and
SXM users (with an active Spectrum Analysis subscription). This version works
with or without an internet connection. Proceed to Standalone Version Installation
section for the installation steps.

%( Notes: For Windows users:
- If you receive a permission error during installation, right-click on the installer file and
select ‘Run as administrator’.

- If your antivirus software blocks the installation, temporarily disable it and try again

- The common "code 299" error can be safely ignored — it does not affect installation
or functionality.

Spectraware - Spectrum Viewer User Guide v1.2.0
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Standalone Version Installation

For Windows installation,

1.

Double-click on the
Spectraware Spectraware [version] [product] x64.exe executable file to
launch the Setup Wizard, then follow the prompts to select your installation
options to proceed.
Replace:

e [version] with the Spectraware version downloaded.

e [product] with ‘RTSA for RTSA users and ‘SXM’ for SXM Solution

users.

On the Ready to Install prompt screen, review your installation settings. Click
Install to proceed with the installation, or Back to change your settings.
When the Setup Wizard has completed the software installation, click Finish to
exit the Wizard.
After installation, a shortcut named “Spectraware” should appear in your Start
Menu and/or on your Desktop (depending on your install options).
Click the shortcut to launch the application.

For Linux installation on Debian based distributions (Debian, Ubuntu, etc.),

1.

Spectraware relies on other third-party libraries, these dependencies need to be
installed first. To find out what dependencies you will need, run in a Terminal the
following command:

sudo dpkg -I Spectrawarespectraware-[version]-[product].deb

Replace:

e [version] with the Spectraware version downloaded.

e [product] with ‘RTSA for RTSA users and ‘SXM’ for SXM Solution

users.

Install the required dependencies using sudo apt-get install <package>
command as needed. The list below provides an example of the necessary
dependencies; however, the exact packages may vary depending on your
system configuration.

sudo apt update

sudo apt install -y ffmpeg libfontconfig libopenglO libegll

libxcb-cursor0 xdg-utils libnss3 libgtbcoreb5a libgtbSwidgets5
libgt5guib libgt5dbus5 libqgtbSnetwork5 meta-utils

‘-y’ option is to be used as needed.

Note: For Users using WSL via Windows, this installation might be needed:

sudo apt install 1libgtk-3-0

In addition, Spectraware might not be able to discover the devices through WSL, manual
IP or addition USB configuration might be needed.

3. Start the Spectraware installation:

sudo dpkg -1 Spectrawarespectraware-[version].deb

4. After installation, a bash shortcut called “Spectraware_Spectraware” should be

created in your system as well as in /usr/bin.



5. To start the application, either click the installed shortcut icon or type the name
Spectraware Spectraware in a terminal window.

5. If the installation fails due to missing dependencies, follow these steps to
recover:

sudo apt install -f
sudo dpkg -r Spectrawarespectraware

Then start again from step 1.

%l\ Note: Spectraware and the Linux installation instructions have only been tested on
Ubuntu 22.x and 24.x, with limited testing on Fedora and Debian.

Running Spectraware and Connecting to an RTSA Device

This section explains how to connect an RTSA device to the Spectraware application to
view real-time signal data.

When launched, Spectraware automatically for available RTSA devices and displays a
connection dialog listing:

¢ network-connected RTSA devices on the same subnet as the host computer. If
your device is on a different subnet, you can manually enter its IP address.
o USB3 RTSA devices, if directly connected.

Connect Device

RTSASIN

250312269

10.126.110.103
10.126.110.110
10.126.110.145
10126 110111

10.126.110.150

Figure 3: Start-up Screen for RTSA users

Caution: Connecting to an RTSA device that is already in use will interrupt the active
session. Current RTSA devices do not support multiple simultaneous connections.

1. Launch the installed Spectraware from your computer.

2. When Spectraware launches, a Connect Device dialog will appear (see Figure
3).



The Connect button will only become active once the Spectraware_Server
(back-end agent) is running in the background.

Select a compatible RTSA device from the list, or manually enter its IP address in
the IP input field below the list if it was not automatically

If your RTSA device (USB or network) does not appear in the list, click Refresh
List to scan again.

The IP input field will auto-fill with the first detected device and update when you
select a different device from the list.

Click the Connect button to start the connection.

Note that an entry of a detected device can also be double-clicked to connect
directly.

Upon successful connection, the Spectraware user interface will begin displaying the
captured signal using the default application settings, which includes the maximum
frequency span supported by the RTSA used.

6.

To connect to a different RTSA device, first disconnect from the previous device
by clicking Device > Disconnect Device in the Menu Bar. The Connect Device

dialog will reappear, allowing you to repeat steps 3 to 5.

Running Spectraware and Connecting to an SXM Device

This section explains how to connect to an SXM device with the Spectraware application
to view real-time signal data. To proceed, you'll need a valid SXM Dashboard account
and access to your assigned SXM nodes.

Before connecting, make sure you have the necessary login credentials, as described in
the next section.

Obtaining SXM Node’s IP and Password

The SXM node is an loT device that is managed through the Node Management
application of the SXM Dashboard. A node’s typical information panel is as follows:

Ceneral

CNSS

[ Orire ]

Software Information

Local App Password

Ma valid
Mo valid €
Mo valid

If the node is online and its ethernet port is connected to a local network or the user’s
computer, an IP Address will be displayed under Local Connection section as shown in
the picture above.



To access data from an SXM node, licensed users must log in using the following
credentials:

Log In Information:

for all users)

e Password: Available from your
_ SXM account administrator. This

value is listed as Local App

Password in the node’s information
panel on the SXM Dashboard.

Running Spectraware Application

Caution: Connecting to an SXM device that is already in use will interrupt the active
session. Current SXM devices do not support multiple simultaneous connections.

1. Launch the installed Spectraware from your computer. A startup dialog screen as
shown in Figure 4 will be displayed. While the initial screen differs from the RTSA
version, the application functions the same after connection.

SXM I Spectraware

Access ultimate visibility into RF spectrum.

Figure 4: Start-up Screen for SXM users

2. SXM users have three connection options, depending on how the SXM devices
are connected and whether the users also own RTSA devices. Users without
RTSA devices can disregard the RTSA connection option.

a. SXM Node - Direct Connection: Use this option if you're connecting your
computer directly to the Node’s Ethernet port, or through a switch that
connects both devices. The option is also recommended for when the node
lacks an internet connection or has a slow or restricted SIM connection, as
direct connection offers faster data transfer to Spectraware.

Refer to Obtaining SXM Node’s IP and Password section for the password.
The IP is only available if the node is online.



SXM I Spectraware

Access ultimate visibility into RF spectrum.

Connection Method:

Log In Information:

node.control

i. Node login credential is required. Enter the node’s Password and click
on Connect to proceed.

ii. After login, the node and the Spectraware application will automatically
establish a connection. This may take up to 5 minutes due to AutolP
configuration and background discovery.

iii. If a connection issue occurs, follow the instructions shown in the pop-up
message.

Once connected, the Spectraware interface will display live signal data with a
default span of 200 MHz. This reduced span (compared to RTSA default) is
optimized for SXM node performance, especially over slower connections.

iv.  To connect to a different SXM device, first disconnect from the previous
device by clicking Device > Disconnect Device in the Menu Bar. The
Spectraware will display the startup dialog, and from there you can
repeat the steps.

SXM Node - Manual IP Input: Use this option if you know the Node’s IP
address, either assigned by your IT network or available through the Node
Management section of the SXM Dashboard, where the Node’s information
is displayed. For the latter, the IP is available on the SXM Dashboard only
when the node is online via supported SIM or local network.

Refer to Obtaining SXM Node’s IP and Password section for the IP and
password.



C.

SXM I Spectraware

Access ultimate visibility into RF spectrum.

Connection Method:

SXM Node - Manual IP Input

Manually Enter the Node IP:

Log In Information:

node control

i. Node login credential is required. Enter the node’s Password and click

on Connect to proceed.

ii. Ifanissue arises during the login and connection stage, follow the

suggested action from the popup message.

Upon successful login, the Spectraware user interface will begin displaying the
captured signal using the default application settings with 200MHz frequency

span. This default span differs from the RTSA’'s usage default because SXM
nodes may be limited by network speed. Using a smaller span instead of the
receiver’'s maximum helps optimize data transfer and overall performance.

iii.  To connect to a different SXM device, first disconnect from the previous
device by clicking Device > Disconnect Device in the Menu Bar. The

Spectraware will display the startup dialog, and from there you can

repeat the steps.

RTSA - Connect Device: Use this option if you are an SXM user with access

to an RTSA device. Follow the same steps outlined in the Running

Spectraware and Connecting to an RTSA Device section.

SXM I Spectraware

Access ultimate visibility into RF spectrum.

Connection Method:

RTSA - Connect Device v

210406-023

250305-123

191204-804

250305-260

No login credentials are required, as shown in the following figure.

10.126.110.103

10.126.110.110

10.126.110.145

10.126.110.111

10.126.110.150




Uninstalling Spectraware Software

For Windows, its native uninstallation application could be used; otherwise, the user’s
selected install directory will contain unins000.exe which can be used to uninstall the
“Spectraware_Server” and “Spectraware_Client”.

For Linux, open a terminal window and run the following command:

sudo dpkg -r spectraware

for the Standalone version.



Spectraware Spectrum Viewer

‘ Spectraware Spectrum Viewer

The Spectraware Spectrum Viewer application provides several options for controlling
and displaying signal captured through a thinkRF RTSA product. For example, you can
specify the frequency span and amplitude, adjust the RBW, change how the spectrum
data is windowed, add or remove traces, and add and manipulate markers.

Viewer feature to configure the connected RTSA, it does not go into detail what the

%‘( Note: This section provides the explanation regarding how to use Spectraware Spectrum

configuration on the device entails. Refer to the RTSA product specific documentations
for such details (see Obtaining Latest Documentation and Software).

The Spectraware Spectrum Viewer application supports the following displays:

Spectral Plot (default, main display)
Persistence Plot

Spectrogram, and

Time Domain Plot

This section will go over these plots in detail. When these plots are enabled along with
the Spectral Plot, the plots can be resized as needed.

Understanding Spectral Plot

The Spectral Plot of Spectrum Viewer (see Figure 5 below) shows the processed
power spectrum of a captured signal as a function of frequency, in real-time or
playback. It is controlled by Amplitude, Frequency and Bandwidth Settings on the
left panels. The plot image below shows the various information pertaining to the
plot as such:

Start, Center, Stop, Span and RBW - the actual values of the spectrum as
returned by the libtrf API (which might be slightly different from the input settings).
Refresh Time — the GUI's refresh rate for each plotting update time.

Sweep Time — the RTSA sweep capture time for the specified frequency range,
from the first to the last sample of the sweep.

Sweep Speed - the RTSA sweep rate of the specified frequency range.

Zoom Control bar — an interactive slider for navigating and exploring the
spectrum while the spectrum is zoomed in.

Span Control bar - an interactive slider allowing users to conveniently adjust the
Start, Stop, Span, and Center frequency values simultaneously.



Figure 5: Spectral Plot, in dark mode

The top panel contains trace and marker (when available) information and the cursor
control buttons.

Zoom Control Bar

In the Spectrum Viewer application, the Show Zoom Control toggle button is located at
the top right of the Spectral and Time Domain plots. It shows or hides the Zoom Control
slider bar located beneath the main Spectral plot.
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The Zoom Control bar provides an overview of the entire specified spectrum span. It
allows users to control the horizontal zoom of the main plot by dragging the white left
and right handles on the Zoom Control bar. This enables a closer look at specific
frequency regions without altering the actual Frequency settings menu.

While dragging a handle, a tooltip displays the exact x-axis value, indicating the current
boundary of the zoomed-in view. To zoom out, simply drag the handles outward to widen
the range, or double-click anywhere on the main chart to reset the zoom to the full span.

Users can perform zooming on the main plot directly as well; the glider of the Zoom
Control bar will adjust accordingly.

Display Persistence Plot

The Persistence Plot is a view of how long a signal remains present; as the signal grows
weaker, the trace fades in color to eventually disappear as time lapses, as shown in
Figure 6. The amplitude is displayed on the vertical axis, and the frequency on the
horizontal axis.
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Figure 6: Persistence Plot shown below the Spectral Plot

1. To view the plot, click on the Persistence button located on the top-right button
panel of Spectraware. The Persistence Plot appears below the Spectral Plot or
marker table when activated.

2. To select which trace the plot is tracking, click the Trace dropdown which
contains active trace numbers on the top right of the plot and select the
appropriate trace. The default value of the Trace dropdown is the first active trace
number.

3. To hide the Persistence plot, click on the Persistence button again.

Display Spectrogram

The Spectrogram (a.k.a. Waterfall Plot) displays spectrum changes over time in a three-
dimensional view, as shown in Figure 7. Time is displayed on the vertical axis and
frequency on the horizontal axis. The amplitude of the frequency components is
expressed by user-adjustable color gradients located to the left of the display.
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Figure 7: Spectrogram Plot below the Spectral Plot

1. Click the Spectrogram button located on the top-right button panel of
Spectraware. The spectrogram appears below the Spectral Plot / marker table
(when activated) / Persistence Plot (when activated).

2. The color gradients of the signal display can be enhanced by sliding the flags on
the color palette (left side of the display) to adjust the threshold at which the
signal changes the power levels. This allows for better contrasting of signal levels
against the noise floor level.

3. To change the trace to which the spectrogram is mapped, click the Trace
dropdown at the top right of the spectrogram and select the trace you want.

4. The spectrogram is equipped with cursors and a crosshair much like the Spectral
Plot (see Adding Cursors and The Crosshair for more details). They can be
toggled on and changed in much the same ways as the Spectral Plot. The largest
difference is that horizontal markers can only have their values changed by
dragging, not edited via the input. The vertical axis measures the time at which a
frame on the spectrogram was captured in 24-hour form with thousandth-second
accuracy (a time reading might look like: 15:43:21.601).

%)\ Note: The spectrogram will be reset when Window Type, Reference Offset and actual
Frequency Settings values applied to the RTSA are changed. Please note that
sometimes small changes of Frequency Settings won’t trigger spectrogram reset as the
actual values applied to the RTSA didn’t change.

Display Time Domain Plot

A Time Domain Plot of a captured signal complements the frequency-domain display and
is useful for visualizing the signal’s voltage level over time. It shows a time-domain IQ



waveform in green for in-phase (I) data and another in red for the quadrature (Q) data
when available. Figure 8 shows an example of the time domain 1/Q waveforms.

Time Domain plot is only available for spans less than or equal to an RTSA’s usable
IBW. This value varies with different RTSA products.

e For R55x0/R57x0, the value is 40MHz.
e For R6000, the value is 100MHz.
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Figure 8: Time Domain Plot below the Spectral Plot

1. Click the Time Domain button located on the top-right button panel of
Spectraware. The Time Domain Plot appears below the Spectral Plot / Marker
table (when activated) / Persistence Plot (when activated) / Spectrogram (when
activated).

2. To hide the Time Domain Plot, click on the Time Domain button again.

%k Important Note: Time Domain plot makes use of the RTSA’s streaming feature, which
allows for fast data availability. However, the RTSA always captures faster than the host
side’s transfer rate. This results in data being stored in the RTSA's internal buffer.
Therefore, for any given settings, the expected signal might not show up right away as it
might still be in the buffer, waiting to be transferred out.




‘ Configuring Spectrum Viewer

&

This section describes the settings that affect the signal capture and display of the
Spectrum Viewer application.

Important Note: The input values of Center, Span, Start and Stop frequency and RBW
may differ from the actual values shown under the Spectral Plot. The actual values are
calculated by the underlying RTSA API (libtrf) based on the hardware’s sample rate.

Configuring Signal Capture

Configuring Amplitude Settings

The Amplitude Settings panel of the left-side panels manages power levels and offsets
for the device and the Plots.

. Auto Scale: Performs a one-time adjustment to the Reference

Level and vertical scale to fit the current signal range. This is useful for quickly
viewing the full dynamic range of the signal, including the highest and lowest
points in the graph.
Continuous Auto Scale: Keeps the Reference Level and scale
automatically adjusted continuously, ensuring the full signal range remains visible
as it changes in real time.
Reference Level: Controls the upper value of the spectral plot’s Y-axis, which
indicates the maximum power level that can be displayed. Adjust it to bring
signals into view.
More importantly, the Reference Level also controls the RTSA’s attenuation and
gains to provide an applicable sensitivity level. The higher the reference level the
more attenuation, and vice versa. The default value is -50dB. The minimum and
maximum values vary with different RTSA products.
Manual Max Y Power: Enables manual control of the Y-axis upper limit on the
@ Manual MaxY Power spectrum chart. When checked, the Max Y Power input field
MaxY Power becomes editable, allowing users to fine-tune the Y-axis scale
5000 for a more detailed view of the graph. When unchecked, the
Y-axis maximum adjusts automatically based on the
Reference Level. This setting does not affect the Reference Level or any other
amplitude values.
Scale / Div: Controls the distance between the major Y-axis tick marks (major
horizontal divisions) on the spectral plot. It is useful for zooming in or out to the
signal. The range is 0.1dB to 20dB, with 10dB as the default.
Reference Offset: Changes the signal’s location within the plotted scale. Also
used for adjusting known discrepancies between the displayed signal and the
actual signal reference location. It does not affect the device’s input signal. The
range is -200dB to 200dB, with 0dB as the default.

Configuring Frequency Settings

Based on the chosen span and frequency ranges, the Frequency Settings panel, the
middle among the left-side panels, leads Spectraware to configure the device to switch
between sweep-tuned mode or single frequency step capture mode. Span and frequency
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ranges also affect the down-sampling rate and dynamic ranges of the device as managed
by Spectraware and libtrf.

e Center — Span - Start — Stop: These four parameters run in coupled mode such
that when one of them is changed, they all change when necessary to maintain
accurate frequency endpoints, center frequency, and span. The minimum and
maximum values of these parameters vary with different RTSA devices.

Note: For SXM users, the maximum span is restricted to 200MHz, regardless of the
RTSA's full capabilities. This restriction is in place because SXM nodes may be
constrained by network bandwidth or speed. Using a smaller span helps optimize data
transfer and improve overall performance and usage experience.

e The absolute minimum span is 12.5kHz. The minimum span can also be reached
by adjusting Start or Stop in the direction of the other endpoint. When reached,
further adjustments move the Center frequency with the Span remaining at
minimum value. Hitting the minimum or maximum frequency for the device will
adjust these four parameters appropriately until minimum or maximum frequency
is reached.

e The minimum span will also be adjusted based on the RBW by preventing
frequency Settings resulting in an incredibly low number of data points that the
RTSA won’t support. The underlying algorithm will adjust RBW or put limits on
Span to achieve this, though this usually will not impact users in a meaningful
way. See the Configuring Bandwidth Settings for more clarification.

¢ Show Span Control: Toggles the visibility of the Span Control located at the
bottom of the app. The Span Control is an interactive slider that lets users adjust
the Start, Stop, Span, and Center frequency values. Dragging the left or right
handles updates the Start or Stop values, while dragging the colored selection
bar adjusts both simultaneously.

Caution: Increasing Span while leaving RBW in manual mode at a very low value will
dramatically increase sweeping times, which might make Spectraware less responsive.

Tip: If you're unsure of the device's full span, you can simply enter a very large number
(e.g., 9999999) into the Span field, the Spectraware will automatically adjust it to the
maximum supported value. Alternatively, you can drag the right handle of the Span
Control all the way to the right.

e Increment Step: The step value for changing any frequency fields in this panel

when pressing the up/down = arrows or when using the middle mouse scroll on
top of Center, Span, Start, and Stop fields. The range is 0.1 to 1000MHz, with 1
as the default.

o Reference Clock: Allows you to change the reference clock between Internal,
External, and/or GNSS when available. Refer to the RTSA’'s product manual for
more information on the options (see Obtaining Latest Documentation and
Software).



Configuring Bandwidth Settings

Spectraware provides the resolution bandwidth (RBW) field and signal processing
Window options to apply to RTSA captured data for plotting.

e Auto RBW: When selected (by default) causes the RBW to be recalculated on
every frequency range adjustment to provide the optimum balance of resolution
and speed.

o RBW: Increase the RBW for faster sweep speeds or lower for finer signal
resolutions. Adjusting this control directly will disable Auto RBW. The minimum
RBW and maximum RBW varies with different RTSA products. The minimum and
maximum RBW are also affected by the Span to prevent the Spectraware
becoming too resource consuming or to prevent settings that would yield next to
no data.

Caution: Leaving RBW in manual mode at a very low value while using a large frequency
span will dramatically increase sweep times, which might make Spectraware less
responsive.

To keep an optimal performance, Spectraware controls and overwrites the smallest
allowed RBW to constraint the maximum number of data points at a given Span.
Therefore, it is important to note that the minimum RBW value allowed in Spectraware
does not reflect the actual min value supported by the RTSA, which could be down to 1
Hz.

e Window Type: List of windowing options to apply to the spectral data. The
default window type is Hann, when available.

Configuring Measurement Settings

Spectraware provides power measurement settings such as the channel power
measurement for a specific span in the current Spectral Plot or the occupied bandwidth of
a given power percentage.

Channel Power

The Channel power feature measures the average of all the power within the defined
start and stop frequency. In other words, it is the power integrated over the frequency
band of interest, with the results expressed in dBm.

Click the Channel Power button in the right-side configuration panel to view its settings
and the measured data (while active).

e Status: Toggles to turn on/off the channel power measurement. When turned on,
it will disable the Occupied Bandwidth measurement if activated.

e Trace: Select the trace for which channel power is being measured.

e Frequency Start: Sets the lower boundary for the channel power region of
interest.

e Frequency Stop: Sets the upper boundary for the channel power region of
interest.

The frequency range is set to 50% of the current spectrum by default. When activated,
the range is also reflected on the Spectral Plot as a transparent blue highlighted channel
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power region of interest, as shown in Figure 9. The measured channel power result can
be seen at the bottom of the Channel Power panel.

When the channel power measurement is not active, the measured channel power
displays 0dBm.

Hint: Mouse dragging could be applied to the highlighted region or to each vertical line to
quickly change the frequency settings for the channel power computation.

24100 200000 2 40000 2 442000 2 450000 2 460000 2470000 2 490000 2 490000

Rt e e B e e et s A ARy |

Figure 9: Channel Power measurement view

Occupied Bandwidth

The Occupied Bandwidth (OBW) feature finds the bandwidth (i.e., frequency range)
containing the user’s specified percentage of the total integrated power in the spectrum
displayed.

Click the Occupied Bandwidth button in the right-side configuration panel to view its
settings and the measured data (while active).

e Status: Toggles to turn on/off the occupied bandwidth measurement. When
turned on, it will disable the Channel Power measurement if activated.

e Trace: Select the trace for which the occupied bandwidth is being measured.

o Power (%): Choose the percentage of the channel power for which the occupied
bandwidth is to be found. The default value is 99.999%.

When turned on, a blue highlighted region appears on the graph showing the region in
which the specified power % is contained, as shown in Figure 10. Below its control fields,
the results for the occupied bandwidth and the start and stop frequencies are displayed.
They appear as 0 when Occupied Bandwidth is not active.



Figure 10: Occupied Bandwidth measurement

Customizing the Spectral Plot Display
Spectraware supports up to:

e six spectral traces on the Spectral plot;

e six markers for peak detection and analysis on the traces; and

e two horizontal and two vertical cursor lines, which may be added to the Spectral
Plot to mark specific power or frequency locations, respectively.

A crosshair cursor is also available for convenient reading of the power and frequency
values at the crosshair point.

Adding Traces

You can configure up to six traces in the signal display, as shown in Figure 11. By default,
the first trace is initially configured to actively display the power spectrum of the captured
signal (a “Normal” and “Active” trace). The following procedure applies for changing a
trace:

1. Click the Traces button in the right-side configuration panel to access the Traces
panel.

2. Select a trace by clicking on a number (from 1 to 6) from the tabs at the top of the
trace panel. Activate it by selecting Active in the Status drop-down list.

3. Inthe Status drop-down list, select a state for the trace:

View Type Description

Off Trace is turned off. The tab for that trace is colored grey.
Active Trace is turned on. The tab for that trace is colored red.




View Pause the current trace, which is equivalent to Trace Hold on
other spectrum analyzer equipment. The tab for that trace is
colored blue.

4. In the Type drop-down list, select a display mode for the trace:

Trace Type Description

Normal Plot the power spectrum result of each captured signal.

(Default)

Max Hold Plot and hold the maximum power values across frequency for
the captured signals.

Min Hold Plot and hold the minimum power values across frequency for

the captured signals.

Average Plot the weighted smoothing average spectrum based on the
following formula:

A=A *a)+ S *(1—a))
where:
A" = New Calculated Average
A = Average Spectrum Signal
a = Weighted Filter, (0 — 0.99)
S = Incoming Spectrum Signal

5. The Color field may be used to select a different color for the trace if desired.
6. Repeat steps 2 - 5 for each additional trace (to a maximum of six).

N Note: Each trace type color and status are also indicated on the information section of
the top panel above the Spectral Plot.

7. Click the Reset button to reset the selected trace on the display. This means that
if the trace is of Min Hold, Max Hold or Average, accumulated results will be
discarded, and the trace will start fresh. The Reset button is only enabled when
the trace is in Active mode.

8. Click the Reset All button to reset all traces on display.

9. To turn off a trace, change the Status field to Off.

Spectraware - Spectrum Viewer User Guide v1.2.0



Figure 11: Spectrum with several active traces

Adding Markers and Finding Peaks

Up to six markers may be added, configured and have their results saved to a CSV file.
Markers are positioned on the Spectral Plot in association with an active trace (i.e. trace
in Active or View status) to identify peaks or differences in power and frequency relative
to another primary marker, as shown in Figure 12. When peak search is applied, the
currently selected marker is positioned at the highest peak on the signal.

Follow these steps to use the Markers feature:

1. Click the Markers button in the right-side configuration panel to access the
Markers panel.

2. Select a marker (from 1 to 6) from the tabs on the top of this panel.

3. Inthe Mode drop-down list, select a mode:

Mode Description
Off The marker is removed from the display. When turn off a
marker, its settings will be reset.
Normal The marker tracks the amplitude (power) value of the active
(Primary trace but remains at the same frequency position unless
Marker) Continuous Peak search is applied. Upon first activation, the

marker is positioned at the Center frequency by default.

The marker appears as a diamond shape with its marker
number hovering above it in the display.

Fixed The marker stays at the same frequency and power level,
(Primary regardless of changes in the amplitude of the incoming signal.
Marker)

The marker appears as a diamond shape with its marker
number hovering above it in the display.

Spectraware - Spectrum Viewer User Guide v1.2.0



Mode Description

Delta <n> When more than one marker is active and at least one is a
primary marker, a marker may be set as a Delta Marker
relative to a primary marker <n>.

For example, if there are two primary markers on the signal
display, you can designate Marker 3 as Delta 1 (relative to
marker 1) or Delta 2 (relative to marker 2). The Delta Marker
allows users to compare frequency and power between two
markers.

The delta marker appears on the display as an inverted triangle
icon with its marker and delta numbers hovering above it.

%{ Note: When turning off a trace with attached marker(s), the corresponding marker(s) will
be turned off.

i Note: Each activated marker’s frequency and power are also indicated on the information
L%)\ section of the top panel above the Spectral Plot.

4. Inthe Trace field, assign the marker to a trace from the trace drop-down list
containing all active traces on the display. This field defaults to the first active
trace (usually Trace 1).

5. In the Frequency field, specify a frequency value to position the marker.

: Hint: A marker can be clicked and dragged directly on the display to a desired frequency
%( position. This action will also set the marker being dragged as the currently selected
marKer.

6. The Power field, which is only editable for a fixed marker, shows the power level
of the marker in real-time.

7. Optionally, a marker can be configured to indicate a peak in its associated trace
by clicking on one of the following buttons:

¢ Peak Search: positions the marker at the highest peak signal of the
current trace.

o Next Peak: positions the marker at the next highest peak signal,
wherever it occurs.

o Next Peak Left: positions the marker at the highest peak signal to the
left of the current marker position.

o Next Peak Right: positions the marker at the highest peak signal to the
right of the current marker position.

e Marker -> Center: changes the center frequency to match the current
marker position.

8. Select the Continuous Peak checkbox to have the Normal or Delta (not Fixed)
marker track the highest peak on each new capture as it occurs on the display.
When this checkbox is selected, most marker settings aside from Mode, Trace,
and Peak Threshold are disabled as all the frequency change or peak search
results are quickly overwritten by the continuous search.

Spectraware - Spectrum Viewer User Guide v1.2.0



9. Select the Peak Threshold checkbox to enable definition of the minimum power
threshold for the peak detection. Markers are not assigned to peaks that fall
below this power level.

Repeat steps 2 to 9 for each additional marker (to a maximum of six).

10. Optionally, click the Show Marker Table switch to display a table listing all active
markers (with their corresponding marker mode, trace assignment, frequency,
power level, frequency delta and power delta) below the Spectral Plot, as shown
in Figure 13. The marker table can be closed by clicking the Show Marker Table

switch again or the Close button above the marker table.
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Figure 13: Marker table below the Spectral Plot

11. Optionally, the information of the current markers (power level, frequency position
and delta values) may be saved in a CSV file by clicking on the Save Marker

Values button or the Save button above the marker table. Specify a file
name and location in the Save As dialog and save it.

12. To remove a single marker, change the Mode field to Off.

13. To remove all markers from the display, click Clear All Markers button.

Adding Cursors and The Crosshair

The cursor buttons are available at the top of the Spectral Plot and Spectrogram.

1. To add a horizontal cursor, click the H1 or H2 button.
2. To add a vertical cursor, click the V1 or V2 button.

When selected, the cursor button will be filled with orange color and with an input
displayed. The input allows users to view or edit the cursor position. The H1 and H2
inputs of the Spectrogram are read-only. By default, the cursor line will be positioned in
the center of the display. The cursors are also draggable by mouse over the top of the
cursor, click and drag them to the desired location on the plot display. When both
horizontal (H1 and H2) / vertical (V1 and V2) cursors are selected, the horizontal (AH) /
vertical delta (AV) will be displayed on the right side of the crosshair button.

Note: Synchronized horizontal and vertical cursors will be displayed on the Persistence
Plot when cursors are added or modified on the Spectral Plot, as shown in Figure 14.
When the cursor is removed from the Spectral Plot, it will be removed from the
Persistence Plot as well.




0
. B
. -
?
L]

Power (48m)

T
i
4
5

Frequency Settings ~

Canter (M) il
2mome; |
Spm 0010
v |
san 00
s
Swp 00)
T

Window Type

I

Power (48m)

2 450000001

Froquency (GHx) Occupied Bandwsch

Recording.

Figure 14: Synchronized cursors on Spectral Plot and Persistence Plot

3. To add a crosshair cursor, click the Crosshair button ] .

4. When selected, the crosshair button will be filled with orange color. When mouse
over the trace(s) in the Spectral Plot, the x and y values of trace(s) will be
displayed on a green tooltip, as shown in Figure 15.

5. When mouse over the Spectrogram, the Time and Power will be displayed on a
green tooltip, as shown in Figure 16.

Note: When the Crosshair cursor is activated, activated horizontal or vertical cursors are
no longer mouse selectable for dragging; use their input to change the cursor position.

6. To remove any cursors or crosshair from the display, click on their button again.



Figure 15: Spectral Plot with cursors and crosshair buttons selected
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Figure 16: Spectrogram with cursors and crosshair buttons selected

Restoring Spectrum Viewer Defaults

)

The Preset button in the top-right button panel of Spectraware provides a means to
reset all parameter values to the application’s start-up defaults. If you want to save your
custom settings before restoring the system defaults, see the Saving Configuration
Settings section.
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‘ Capturing Signal Data

In addition to viewing real-time signal data on the Spectraware web application, signal
data and information can also be screenshot handily or saved for playback or for further
processing by another application.

Capturing a Screenshot

Spectraware allows for capturing a screenshot of the current window. The screenshot is
stored in the PNG file format.

1.
2.

3.

Click the Take Screenshot button in the top panel of Spectraware.

In the Save As dialog, specify a file name (or use the default) and a storage
location.

Click Save to save the image.

Recording Signal Data

Spectraware allows recording real-time signal data in a file for playback or further
processing by another application. The data file will be saved settings to the user’s local
home directory.

When saving data, Spectraware also saves two .json files with full application settings.
These files allow for automatically loading those settings to restore the visual application
state when playing back a data file.

To record data to a file:

1.

2.

Click the Recording button in the right-side configuration panel to access the
Recording panel.

Set the Duration in seconds, indicating how long you want to record data for.
The range is 1s to 86400s (24 hours), with 10s as the default.

Before you record, check if you are presently viewing data in the time domain. If
you are, the recording will be saved as such. Otherwise, it will be saved as
frequency domain.

Click Start Recording. A Save As dialog will be shown. Specify a file name and
save it. The default file name format will be as such:

Recording Type Default File Name Format

Specvun1 spectrumbData sn[serial number] span[span
frequency] fc[center
frequency] rbw[RBW] ts[yyyy-mm-dd-hhmmss]

Time Domain igData_sn[serial
number}_IQToSpectrum_ifbw[RBW]_fc[center

frequency] ts[yyyy-mm-dd-hhmmss]

FM igData sn[serial
Demodulation number] FMDemodulator ifbw[analysis
BW] fclcenter frequency] ts[yyyy-mm-dd-hhmmss]




Recording Type Default File Name Format

AM igData sn[serial
Demodulation number] AMDemodulator ifbw[analysis
BW] fclcenter frequency] tslyyyy-mm-dd-hhmmss]

5. A progress bar will appear on the panel indicating how much of the recording
duration has passed, and the Start Recording button will turn into a Stop
Recording button.

%( Note: While recording, you will not be able to change most settings, and a recording icon
will be displayed beside the Recording title.

6. You can click the Stop Recording button at any time to stop the recording and
save the captured data. Otherwise, the recording will stop when the duration is
reached, and the captured data will be saved.

7. The recorded data will be saved as a raw data file with corresponding settings
files.

Playing Back a Recorded Signal

Spectraware can playback a previously recorded signal. The following steps can be used
to playback a signal.

1. Click the Playback button in the right-side configuration panel to access
Playback panel.

2. Click Choose File. An Open dialog will be shown. Choose the desired file and
click Open (or double click on the file).

f Caution: File name containing “.” is not supported and will cause file saving failure.

3. The Spectraware will begin displaying the signal. In the Playback panel, a
Progress Bar will appear to indicate how far through the playback the current
frame is in the form of a percentage value. When continuous (looping) playback
of a file is used and happens rapidly, the Progress Bar might give an impression
of never reaching the end.

%( Note: During playback, a playing back icon will be displayed beside the Playback
title. Also, all the settings except Scale/Div, Reference Offset and Window Type (in
time-domain playback only) in the left-side configuration panels will be disabled as those
settings can no longer be changed during playback. The File and Device menus in the
Menu Bar will also be disabled as they are not supported in playback.

4. To stop playback of the recorded file, click the Stop Playback button in the
Playback panel. If a device was connected before playback, Spectraware will
reconnect to that device. Otherwise, the Connect Device dialog will be shown.
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’ Note: When a recorded FM/AM Demodulation file is selected for playback under the
%k Spectrum Viewer page, it will switch to the Demodulation page automatically and play the
data. Similarly, when a recorded spectrum/time domain file is selected for playback under
the Demodulation page, it will switch to the Spectrum Viewer page automatically and play

the data.

5. Alternatively, from the Connect Dialog, you can start a playback by clicking the
Open Playback button and doing steps 2 and 4.

Spectraware - Spectrum Viewer User Guide v1.2.0



‘ Demodulating Data

Spectraware can demodulate AM and FM signals. Click the Demodulation tab in the
Feature Navigation Headings to launch the demodulation page (see Figure 17). The
receiver is placed into a gapless streaming mode.

Demodulation Page
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Figure 17: Demodulation view

The demodulation page has configuration panels and control buttons surrounding three
main plots as such:

o Left-side configuration panels contain demodulation settings such as
Demodulation Type, Center Frequency and Analysis Bandwidth. More
information on these settings can be found in Configuring Demodulation Settings.

e The top-right button panel contains run control buttons for changing capture
modes and resetting the application. See Run Control Buttons section for more
information.

o Right-side configuration panels contain settings for Capturing Demodulated
Signal Data.

Configuring Demodulation

This section describes the settings that affect the demodulated signal capture and
display.



Configuring Demodulation Settings

Setting Name Function

Demodulation Type Options are AM and FM (default).

Subtype The subtype options are only available for AM demodulation. The
supported subtype values are DSB (Dual-SideBand), LSB (Lower-
SideBand) and USB (Upper-SideBand).

Increment Step The number of MHz by which the Center frequency will step when
(MHz) the Center’s up and down buttons are pressed.
Center (MHz) The frequency to which the Receiver was tuned or to which the

Receiver was tuned when the file being played was recorded.

Reference Level The Reference Level controls the RTSA’s attenuation and gain
(dBm) when applicable sensitivity. The higher the reference level the more
attenuation, and vice versa.

Analysis BW (kHz) Analysis BW (bandwidth) is used to demodulate and filter the signal.
The BW value is defaulted to 244kHz for FM demodulation, and
35kHz for AM. The smallest supported BW is 35kHz.

Configuring Audio Settings

The audio can be turned on or off (default) by clicking on the Status toggle button in the
Audio panel of the left-side panels. This button is only available in continuous capture
mode. When the Status toggle button is On, the audio stream flowing will start. The audio
can be paused at any time by changing the Status toggle button to Off, which will empty
the audio buffer until it turns on again.

Capturing Demodulated Signal Data

Recording Demodulated Signal Data

Spectraware allows for recording real-time demodulated signal data in a file for playback
or further processing by another application. Please refer to the Recording Signal Data
section.

Playing Back a Recorded Demodulated Signal

Spectraware can playback a previously recorded demodulated signal. Please refer to the
Playing Back a Recorded Signal section.



Demodulation Plots

Spectral Plot
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Figure 18: Spectral plot of a mono FM signal

The demodulated spectral plot shows the power spectral density of the signal after
demodulation. An FM signal, for example, has an obvious spectral signature that can be
seen in Figure 18 above.

The cursor buttons are available at the top of the frequency domain graph. The usage of
these cursor buttons is the same as those above the Spectral Plot in Spectrum Viewer.
Refer to the Adding Cursors and The Crosshair section for usage details.

Constellation Plot
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Figure 19: Strong Signal Figure 20: Weak Signal

The constellation graph is always active when there is a connected device or file. It
displays the calibrated signal prior to demodulation (i.e. IQ data) on a unity graph, which



is essentially signal power and phase. The quality of an FM signal is denoted by how
closely the values are plotted to a perfectly clean circle. A perfect circle (see Figure 19)
denotes a clean, strong signal, which will be obvious when listening to the demodulated
signal. As the circle gets more diffuse (see Figure 20), the quality of the audio quality
might be diminished.

Time Domain Plot
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Figure 21: Time domain plot of an FM speech signal

The time domain graph (see Figure 21) shows signal amplitude in voltage over time,
which corresponds to the audio that is played when the signal is down-sampled to
44 1kHz and sent to the audio system.

Note that there might be some small amount of lag from the displayed signal to the
audible signal owing to the need to buffer the audio stream to mitigate the risk of
annoying dropouts.



Administration

In addition to signal capture functionality, the Spectraware application provides additional
features that allow you to save and store configuration profiles and to customize the
configuration panel display.

Saving Configuration Settings

-l

Spectraware allows for saving current configuration settings in a file that can be reloaded
later.

To save the existing Spectraware settings,

1. Open the File menu from the Menu Bar and select the Save Settings option.
2. Specify a file name (default file name format is Spectraware-config-YYYY-
MM-DD-SSSSS) and location in the Save As dialog and save it.

The contents of the saved .json file can be viewed in a text editor, however, however,
manual modification of this file is not recommended.

Note: If you are a user of the libtrf library, the file saved using either libtrf or Spectraware
can be played back by both. This is because Spectraware makes use of libtrf's recording
function directly.

Loading Configuration Settings

-l

Spectraware application settings can be customized based on a previously saved
configuration file.

1. Open the File menu from the Menu Bar and select the Load Settings option.
2. Navigate to the storage location of the .json file to be opened in the Open dialog.
3. Select the .json file and click Open (or double click on the file).

Spectraware loads configuration settings from the file and updates the application state
accordingly.

Note: If an improper format of file is loaded, an error dialog will be displayed with
message “Invalid settings!” and your current settings will remain as normal. If a properly
formatted file is loaded with invalid data for some reason (for example, a letter is where a
number should be), data may fail to be plotted. In this case, click the Preset button to
reset the capture settings.

Viewing Device Information

Information specific to the connected RTSA device can be obtained by clicking Device >
Device Info from the Menu Bar. A dialog with device information will be displayed.

The dialog displays the following information of the RTSA device currently connected to:

e [P Address: the IP address of the device



Model: the device’s model number

Serial Number: the device’s serial number

Product Version: the device’s hardware version
Firmware Version: the device installed firmware version

For the R57x0 and R6000 product family with inbuilt GNSS module, the panel displays
the following additional position information with real-time updates:

Latitude: degrees, minutes, and seconds
Longitude: degrees, minutes, and seconds
Altitude: meters (m)

Speed: meter per second (m/s)

Track: the direction of traveling in degrees

Changing The Display Theme

The Spectraware user interface supports two different themes — Dark (default, Figure 22)
and Light (Figure 23). To change the theme, open the Themes menu from the Menu Bar
and select the desired theme. Changing the theme changes the visual style and color
scheme of the user interface but has no impact on the data display; they are purely there
for aesthetic purposes.
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Figure 22: The Spectraware user interface and its main Spectral Plot in dark mode.
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Figure 23: The Spectraware user interface and its main Spectral Plot in light mode.

Accessing Product Documentation

Access to this User Guide PDF document is available in the Spectraware’s Help menu,
or_this User's Guide link.

See Obtaining Latest Documentation and Software for any other documentation related
to the device or Spectraware.
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https://s3.amazonaws.com/ThinkRF/Published/Manuals/thinkRF+UG+75-0052+-+S1000+Spectraware+User+Guide.pdf

Document Revision History

This section summarizes document revision history.

Document Release Revisions and Notes
Version Date

v1.0.0 07/10/2023  First release

v1.1.0 11/30/2023 e Updated Spectraware Overview section

o Added the new Demodulating Data section.

¢ Changed Getting Started section with new
installation steps for Standalone and Browser mode
and modification throughout the section accordingly.

e Changes to images to reflect new Ul enhancements.

v1.1.1 02/27/2024  Improved Linux installation instructions and a note.

v1.2.0 07/17/2025 ¢ Improved explanations throughout the document
¢ Moved Plot Zooming to be under User Interface
section to serve as a generic usage.

For software release v1.3.0,

- Added:
o thinkRF SXM Solutions support throughout the
document
e sections on new features
o Zoom Control Bar
o “Span Control” bar for Frequency Settings
o “Continuous Auto Scale” and “Manual Max Y
Power” for Amplitude Settings
¢ new figures due to new changes
¢ Running Spectraware and Connecting to an SXM
Device section

- Removed “S1000” or renamed it to be “Spectraware”
where applicable. S1000 naming is no longer needed.
- Renamed “Spectrum Analyzer” to “Spectrum Viewer”
- Removed “Web Version Installation” and its mentioning
throughout the document as this option is deprecated.
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